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Safety Warning 
Always observe standard safety precautions during installation, operation and maintenance of this 
product. Read the installation instructions before you connect the unit to its power source.  This unit must 
be connected to earth ground, do not bypass the grounding system. To avoid the possibility of electric 
shock, disconnect the power cord from the power source before removing the cover or performing any 
repairs. Only a competent technician who is aware of the hazards involved should carry out adjustment 
maintenance or repairs. The operator or user should perform no adjustment, maintenance or repairs to 
the opened instrument. There are no user serviceable parts inside the unit. Do not work on the system or 
connect or disconnect cables during periods of lightning activity. Ultimate disposal of this product should 
be handled according to all national laws and regulations. 
 

WARRANTY 
Unless otherwise specified, all products presented in this user's guide are warranted against 
defects in material and workmanship for a period of one year from the date of sale to the initial 
purchaser. PANDUIT Corp. warrants that its firmware designed by PANDUIT Corp. for use with 
the product will execute its functions when properly installed in the product for one year from the 
date of sale to the initial purchaser. PANDUIT Corp. does not warrant that the operation of the 
product or the firmware will be uninterrupted or error-free. During the warranty period PANDUIT 
Corp. will, at its discretion, either repair or replace products that prove to be defective. For 
warranty service or repair, the product claimed to be defective must be returned to a service 
facility designated by PANDUIT Corp. Buyer shall prepay all the shipping charges to PANDUIT 
Corp. and if, in the opinion of PANDUIT Corp., the product is defective, PANDUIT Corp. shall 
pay shipping charges to return the product to Buyer. However, Buyer shall pay all shipping 
charges, duties and taxes for products returned to PANDUIT Corp. from another country.  
 
The foregoing warranty shall not apply to defects resulting from, buyer-supplied firmware or 
unauthorized interfacing, modification or misuse of the product, operation outside of the 
environmental specifications for the product, or improper or inadequate site preparation or 
maintenance by Buyer.  
 
NO OTHER WARRANTY IS EXPRESSED OR IMPLIED. PANDUIT CORP. SPECIFICALLY 
DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.  
 
THE REMEDIES PROVIDED HEREIN ARE BUYER'S SOLE AND EXCLUSIVE REMEDIES. 
PANDUIT CORP. SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT 
OR OTHER LEGAL THEORY.   
 
Unless otherwise specified by PANDUIT Corp., opening of this product by unauthorized 
personnel will void this warranty. 
 

TRADEMARKS 
DPoE™

 is a trademark of PANDUIT® Corp. All other trademarks are the property of their 
respective owners. 
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OVERVIEW 
The DPoE™ Power Patch Panel provides a reliable and cost-effective solution for Power over Ethernet 
(PoE) applications, complaint with the IEEE 802.3af-2003 specifications. Each DPoE™ Power Patch 
Panel allows centralized powering of up to 24 devices, such as Internet Protocol-based (IP) telephones, 
Network Security Cameras, or Wireless Devices, over the same cabling used to provide the Ethernet 
connectivity. By eliminating separate power connections to each of the devices, the DPoE™ Power Patch 
Panel provides a more cost-effective solution, particularly in cases where the devices are numerous or 
local powering is impractical.  
 
The DPoE™ Power Patch Panel can be used in place of current patch panels to inject PoE power into an 
existing infrastructure without the need for separate non-powered patch panels (i.e., hub architectures), 
which decrease reliability while increasing cost and wiring complexity. 
 
While the DPoE™ Power Patch Panel may be used as a standalone device, it can be configured and 
monitored from a centralized PANDUIT® Element Manager (EM). This management system allows 
network operators to remotely perform routine maintenance and monitoring of any DPoE™ Power Patch 
Panels in their network. The EM allows operators to graphically view and monitor power panel status, 
fault conditions and per-port power consumption. In addition, the EM allows the operator to designate 
power priority to individual ports within each DPoE™ Power Panel.  A higher-level Network Management 
System (NMS) might then use this pre-configured information to guarantee mission-critical devices 
remain operational in the event of low-power conditions. 
 
 

RJ-45 connector 
(one per port) 

Port Status LED 
(one per port) 

Panel Status 
LED 

 23       24

Port number 

 

Figure 1: DPoE™ Power Patch Panel (Front View) 
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A- and B-feed 
(optional) Power 
Connections  

Punchdown 
connections 

OUT management 
port and OUT 
Network Status LED 

IN management port 
and IN Network Status 
LED

 
Figure 2: DPoE™ Power Patch Panel (Rear View) 

 

Features and Benefits 
The following table highlights some of the capabilities of the DPoE™ Power Patch Panel along with the 
tangible benefit to the network operator. 
 

DPoE™ Power Patch Panel Feature Benefit 

Powers up to 24 devices from a 
centralized location  

By using PoE, a network operator can more 
cost-effectively power Ethernet devices up to 
100 m (328 ft.) from the PANDUIT® DPoE™ 
Power Patch Panel. Powering from a 
centralized location eliminates the need to 
power each device separately, eliminates the 
need for separate Uninterruptible Power 
Supply (UPS) for critical devices, and allows 
centralized power management by the 
network operator. 

Combining PoE Power with patch panel 
functionality 

Other vendors use a separate “Power Hub” 
architecture, which doesn’t replace the need 
for additional non-powered patch panels. 
PANDUIT® DPoE™ Power Patch Panel 
combines these two functions into a 1 RU-
high package. This reduces needed rack 
space by at least 50% while providing easier 
installation without the need for patch cords 
between the Power Hub and a non-powered 
patch panel. 
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DPoE™ Power Patch Panel Feature Benefit 

IEEE 802.3af-2003 Compliant Many currently available in-line PoE 
powering options are not standards-based, 
thus requiring coordination between each 
device’s power needs and the technical 
capabilities of the in-line powering unit. 
 
Any port on the PANDUIT® DPoE™ Power 
Patch Panel can support the 802.3af-2003 
standard or the legacy Cisco powering 
scheme.  

Full power to all ports With all ports on the panel capable of 
delivering full PoE power, there’s no need to 
load balance across panels, design special 
wiring schemes or leave ports unused in the 
panel. 

Increased System Reliability The PANDUIT® DPoE™ Power Patch Panel 
does not use an internal fan. Fans reduce 
the system reliability. In addition, the 
eliminated need for separate “midspan” 
patch panels increases the network 
availability. 

Simultaneous support for the Cisco 
powering scheme along with the 802.3af-
2003 standard 

By supporting both methods on each port, 
the DPoE™ Power Patch Panel provides 
ultimate flexibility without the need for 
separate panels for each powering scheme 
and without the need to install separate 
power modules. In addition, devices that 
don’t require PoE powering may also be 
mixed in the same panel. 

Power Prioritization In the event of low-power conditions, a NMS, 
working in conjunction with the DPoE™ 
Power Patch Panels, can use the pre-
established port priorities to ensure mission-
critical ports on the network of panels 
continue to receive PoE power as long as 
possible. 

Easier Local Management Multi-colored LEDs on the DPoE™ Power 
Patch Panel allow technicians to instantly 
know the status of each port. Additional 
LEDs reflect management and panel status. 
Identification labels on the front and rear of 
the system allow the technician to note the 
panel number, the port number and wiring 
scheme information for both the Ethernet 
and PoE sides of the panel. 

Easier Remote Management The optional EM allows network operators to 
easily view and manage a network of 
DPoE™ Power Patch Panels using industry-
standard Simplified Network Management 
Protocol (SNMP). 
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DPoE™ Power Patch Panel Feature Benefit 

Easier Installation By eliminating the need for separate 
midspan patch panels and the associated 
need for patch cord, in a network-ready 1RU 
high package, The DPoE™ Power Patch 
Panel is fast and easy to install. 

INSTALLATION For DPOE24U1X, DPOE24U1XY, DPOE12U1X 
and DPOE12U1XY (For DPOE24S1X and DPOE24S1XY see 
Appendix 1) 
 
The PANDUIT® DPoE™ Power Patch Panel requires a direct connection to a nominal 48VDC supply.  
An individual power supply may be purchased separately from PANDUIT Corp or other vendors.  
Installation instructions for the individual power supply are included with that product. PANDUIT Corp 
provides multiple individual power supply options as listed below. 
 

Table 1: Power Supplies Available from PANDUIT Corp. 
PANDUIT Part Number Description 
DPOEPWRB120 120 watt power brick - 48 volt output 

DPOEPWRCU 

Unmanaged power chassis - supports 3 
rectifiers and optional Network Interface Card 
(NIC) 

DPOEPWRR500 
500 watt rectifier for use in the DPOEPWRCU 
chassis 

DPOEPWRR1250 
1250 watt rectifier for use in the DPOEPWRCU 
chassis 

CORD-A Power cord for Australia 
CORD-E Power cord for Europe 
CORD-S Power cord for USA 
CORD-U Power cord for the U.K. 

 
 

Package Contents 

Each PANDUIT® DPoE™ Power Patch Panel is shipped in a box, which includes the following: 
 

Table 2: Package Contents 
Item Quantity Notes 
DPoE™ Power Patch Panel 1 DPOE24U1X, DPOE24U1XY, 

DPOE12U1X or DPOE12U1XY 
Wiring Template Label 1 For use on the rear panel of the 

DPoE™ Power Patch Panel – 
Supports either EIA/TIA 568A or 
568B wire positions. 
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Item Quantity Notes 
Quick Installation Instructions 1 PANDUIT Part Number PN370 
DPOE™ Installation Worksheet 1 PANDUIT Part Number PN377 
Metric and English screws  12 Installation requires six screws.  

One bag of six metric screws 
(M6x1.0x16) and one bag of six 
English screws (12-24x1/2”) are 
included. 

8 inch grounding strap 1  
DPoE™ Power Patch Panel Support Tools CD-
ROM containing: 
 

- PANDUIT® Element Manager (EM) 
software. 

- DPoE™ Power Patch Panel Users Guide 
(this document) 

- Release Notes 
- Application Notes 
- Installation Guides 

1  

Power connector housing with wire leads 1 This wiring harness is used to 
connect the DPoE™ Power Patch 
Panel to the 48VDC power 
supply. Not used if the panel is 
powered by the PANDUIT Power 
Brick (PANDUIT Part Number 
DPOEPWRB120 or 
DPOEPWRB120Y.) 

10 Foot Power Harness 1 Used to connect the –48V A-feed 
to a power supply.   

Butt splices 2 Two butt splices may be used to 
extend the 10 Foot Power 
Harness. (Do not exceed a total 
length of 35 feet). 

 
Verify the above contents arrived in good condition.  If not, contact PANDUIT Technical Support. 
 
 

Table 3: PANDUIT Corporation Contact Information 

PANDUIT Technical Support Fax: 1-708-444-6993 
E-mail: cs@panduit.com 

For Installation Instructions in Local Languages 
and Technical Support 

www.panduit.com/resources/install_maintain.asp 

Worldwide Subsidiaries and Sales Offices www.panduit.com 

Latest Software Updates www.panduit.com/managednetworksolutions 
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IMPORTANT: The DPOE™ Installation Worksheet should be used to record pertinent 
information when installing DPoE™ Power Patch Panel(s), particularly if the EM is 
monitoring the network.  (See page 29, Provisioning the Panel, for more 
information on how this information will be entered in the EM.)   The installer 
should complete this worksheet.
 

 

Panel Mounting Procedure 

WARNING: Only trained and qualified service personnel should install or service 
DPoE™ Power Patch Panels 

 
WARNING: Before installing or servicing DPoE™ Power Patch Panels or 

communication wiring, be aware of the hazards with the associated 
electrical circuitry. 

Rack Mounting Instructions 

1. Record the MAC address, printed on a 
sticker on the back of the unit, by 
writing it in the space provided on the 
included Installation Worksheet 
(PANDUIT part number PN377). 

2. Slip the Wiring Template Label over 
the rows of connectors on the back of 
the DPoE™ Power Patch Panel, 
making sure the proper wiring code is 
facing out and that the writing is not 
upside down.  One side of the label indicates EIA/TIA 568A wiring, while the other side is EIA/TIA 
568B wiring. 

3. Using a screw from the US standard thread screw set denoted by “01881-38 REV 2,” attach the 
green and yellow striped grounding strap to the panel via the unthreaded hole nearest the 
power connector. Next, install the panel onto a grounded rack using the appropriate screw set 
provided to ensure proper grounding between the panel and the rack. Finally, attach the loose 
end of the grounding strap to the rack within the same position as the panel. 

  
PANDUIT Structured Ground Kits for Data Center Rack Grounding can be used to properly ground 
PANDUIT® NetRack Rack Systems and racks from most other manufacturers. 
 
4. Using four of the enclosed metric or English screws, as appropriate, install the DPoE™ Power 

Panel into the 19” rack at the planned rack position.  
 
WARNING: The supplied screws are part of a grounding system to ensure that the 

DPoE™ Power Patch Panel is properly grounded to the rack.   
 
USE ONLY THE SUPPLIED SCREWS TO ATTACH THE PANEL TO 
THE RACK. 

 
 

Record the rack space position on the Installation Worksheet. 
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From 
Network

 
  

Grounding Requirements 

 
  

 

 

 

 

 

Network Connection 

 

5. If the Element Manager is not being used to 
remotely manage the network of DPoE™ 
Power Patch Panels, skip to Connecting the 
Powered Devices below.  Otherwise, using a 
standard patch cord (for example, PANDUIT 
part number UTPCH3 or UTPSP3), connect 
the IN management port on the back of the 
panel to an Ethernet switch. A DHCP Server 
must be on this network (unless the DPoE™ 
Power Patch Panel has been configured for 
Static IP operation). The panel may also be 
directly connect to a PC with the PANDUIT 
Element Manager installed, but this PC must 
be setup as a DHCP Server.” 

 
 
 

6. If multiple panels are being used in the network, 
the OUT management port from one panel may 
be connected to the IN management port on the 
next panel in a daisy chain fashion, as shown. 
Once all of the connections are made, the EM 
or another Network Manager will be able to 
communicate with all the panels over this daisy 
chain of connections. (See page 29, 
Provisioning the Panel, for more information.) 

 
 
 

Connecting the Powered Devices 

 
7. Remove 1 inch (25.4 mm) of cable jacket being careful not to damage the conductors. 
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8. Fan out all four twisted pairs in the specified wiring 
sequence (see color-coded wiring positions in Table 4: 
Color-Coded Wire Positions for 802.3af-2003 
Compliant Devices and Table 5: Color-Coded Wire 
Positions for Alternate PoE Devices below).  The 
colors are also displayed on the Wiring Template 
Label, already installed on the back of the DPoE™ 
Power Patch Panel. 

 

 
 

The DPoE™ Power Patch panel supports standard IEEE 802.3af-2003 devices as well as 
alternate PoE devices consistent with the Cisco legacy devices. 

 

Table 4: Color-Coded Wire Positions for 802.3af-2003 Compliant Devices 
Pin 
Outs EIA/TIA 568A  

Pin 
Outs EIA/TIA 568B 

5 WHITE/BLUE  5 WHITE/BLUE 
4 BLUE  4 BLUE 
1 WHITE/GREEN  1 WHITE/ORANGE 
2 GREEN  2 ORANGE 
3 WHITE/ORANGE  3 WHITE/GREEN 
6 ORANGE  6 GREEN 
7 WHITE/BROWN  7 WHITE/BROWN 
8 BROWN  8 BROWN 

 

Table 5: Color-Coded Wire Positions for Alternate PoE Devices 
Pin 
Outs EIA/TIA 568A  

Pin 
Outs EIA/TIA 568B 

5 WHITE/BROWN  5 WHITE/BROWN 
4 BROWN  4 BROWN 
1 WHITE/GREEN  1 WHITE/ORANGE 
2 GREEN  2 ORANGE 
3 WHITE/ORANGE  3 WHITE/GREEN 
6 ORANGE  6 GREEN 
7 WHITE/BLUE  7 WHITE/BLUE 
8 BLUE  8 BLUE 

 
 
 
 
 
 

NOTE: The DPoE™ Power Patch Panel can terminate most 22-24 AWG solid or stranded 
IWC wire with a .050” (1.27mm) max o.d. either PVC or Plenum rated. 
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9. Lay conductors into the punchdown slots for the 

specified port using the correct wiring sequence. Cable 
jacket removal should be minimized to the extent 
possible.  Conductor untwist should be within ½” (12.7 
mm) of termination. 

 
  

  
WARNING: NEVER TOUCH UNINSULATED COMMUNICATIONS WIRING OR 

TERMINALS UNLESS THE COMMUNICATION LINE HAS BEEN 
DISCONNECTED AT THE NETWORK INTERFACE. 
 

 
 
NOTE: Never install wiring in a slot previously used for a larger gauge wire. 

 
 
 

 
 
10. Using the punchdown tool (PANDUIT part number PDT110), punch down the connector into the 

punchdown slots on the back of the DPoE™ Power 
Patch Panel. 
 
 
 
 

 
 
 

Power Requirements 

11. If the panel is being powered by a PANDUIT® DPoE™ Power Brick (See page 8, Table 1: Power 
Supplies Available from PANDUIT Corp for a list of available powering options), skip to Powering 
Up the DPoE™ Power Patch Panel Section below, since the brick is equipped with a matched 
keyed power connector that will fit the power connector on the back of the panel. 

12. If the PANDUIT® DPoE™ Power Chassis or a direct 48VDC source is powering the panel, cut 
the 10-foot power harness to length then strip the ends of the leads to 5/16” (7.9 mm).  Connect 
the stripped ends of the power harness into the PANDUIT® DPoE™ Power Chassis. If the power 
harness is not long enough or the 48VDC source requires a specific connector, strip the ends of 
the wire to the same strip length, being careful not to damage the conductors.   

13. Using the two butt splices provided with the panel, and paying attention to the polarity of the 
supply voltage, crimp the power harness wires to the supply wires. A crimping tool, such as the 
PANDUIT part number CT-100, may be used. The provided butt splices (PANDUIT part number 
BSV14X) support 14-16 AWG solid or stranded wire. 
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WARNING: The power supply connections are polarized.  
 
The DPoE™ Power Panel will not function if power is wired improperly. 
 
For Maximum power the overall length of the wire between the power 
supply and the DPoE™ Power Panel must not exceed 35 feet. 

 
 

NOTE: The included power harness has two wires for the A-feed power only (pins 
1 & 2).  The DPoE™ Power Patch Panel supports an optional redundant 
B-feed power option, but the terminals and wire leads are not attached to 
the power harness. 
 
Contact PANDUIT Technical Support for more information about 
connecting the redundant B-Feed Power. 

 
14. Lightly tug on the butt spliced connections to verify that the butt splices are secure. 

Powering Up the DPoE™ Power Patch Panel                   

15. Plug the connector into the back of the DPoE™ Patch 
Panel. 

16. Once power is applied to the unit, the DPoE™ Power Patch 
Panel will go through its power up sequence.  The following 
table describes the behavior of the unit as viewed from the 
front and the back. 
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Table 6: DPoE™ Power Patch Panel Power Up Sequence 
Behavior as viewed from the back of the unit Behavior as viewed from the front of the unit 

Both network status LEDs will light amber for two 
seconds 

The panel status Light-Emitting Diode (LED) will 
light red for about 10 seconds. After that, a LED 
test sequence of the port status LEDs will take 
place, lighting each port status LED amber.  It will 
appear as if the port status LED is “walking” from 
port 1 through port 24.  

If there is no cable connected to the IN 
management port (Step 5 above), both network 
status LEDs will turn off. 

If the Patch Panel is configured for Dynamic Host 
Control Protocol (DHCP) address assignment 
(default configuration) and a cable is NOT 
connected to the IN management port on the rear 
of the panel, the panel status LED will turn green.   

If the DPoE™ Power Patch Panel is configured 
for DHCP address assignment (default factory 
setting), the network status LED above the IN 
management port will stay amber and the 
network status LED above the OUT management 
port will turn off.  This indicates that the panel is 
actively requesting address information from the 
network. Once this information is received (this 
could take up to a minute), the network status 
LED above the IN management port will turn on 
or start flashing green as data is transmitted and 
received. 

If the DPoE™ Power Patch Panel is configured for 
DHCP address assignment (default factory setting), 
the panel status LED will flash amber.  This 
indicates that the panel is actively requesting 
address information from the network. Once this 
information is received (this could take up to a 
minute), the panel status LED will flash green. (See 
page 5, Figure 1: DPoE™ Power Patch Panel 
(Front View) and page 6, Figure 2: DPoE™ Power 
Patch Panel (Rear View) for a graphical view of the 
LEDs on the DPoE™ Power Patch Panel.) 

If the panel were set to static IP addressing rather 
than DHCP, the network status LED above the IN 
management port will immediately turn green. 

If the panel were set to static IP addressing rather 
than DHCP, the panel status LED will flash green 
and continue flashing as long as power is applied 
to the unit. 

 

Basic Troubleshooting  

Use the following guide to help resolve problems installing the DPoE™ Power Patch Panel. If the problem 
persists, contact PANDUIT Corp Technical Support or a local sales representative. (See page 9, Table 3: 
PANDUIT Corporation Contact Information, for contact information.) 
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Table 7: Basic Troubleshooting Guide 
Problem Possible Causes and Solutions 

The panel status LED does not light when power 
is applied to the unit.  

1. The power supply fuse may be blown. Check 
the fuse on the DPoE™ Power Patch Panel 
power supply. 

2. The power connection may be bad. Check the 
physical connection and make sure the voltage 
polarity is proper. 

3. No power is available at the panel. Make sure 
the power supply is plugged in and operational. 

4. The keyed power connector is not seated 
properly. Reseat the power connector. 

The patch panel status LED is flashing green but 
no power is being applied to the connected 
powered device(s). The port status LED over the 
port(s) where power should be provided is off. 

1. The device is not connected properly to the 
DPoE™ Power Patch Panel. Make sure that 
the cable to the connected devices is properly 
terminated on the panel for the type of power 
needed (IEEE 802.3af-2003 or Alternate PoE)1. 

2. The cable is not punched down securely. Re-
punch the 110 connections. 

3. The attached power device is not 802.3af-2003 
compliant or legacy Cisco compliant. Make 
sure that the attached device meets either of 
these standards. Also try to connect the device 
to another port to see if it powers on. 

4. The port Administration Control setting is set to 
OFF in the EM. The Element Manager must be 
used to set the port Administration Control to 
ON. (See page 38, Edit Port Information, for 
more information.) 

 
The panel status LED stays solid red after power 
is connected and over 20 seconds has elapsed. 

1. The power supply voltage is either less than 46 
volts or greater than 57 volts. The panel should 
be immediately disconnected from power and 
the input power should be corrected.   

The DPoE™ Power Patch Panel is providing 
power to the end device, but there is no data 
connection (i.e., the Ethernet connection is not 
working).  

1. The switch is not properly connected to the RJ-
45 jacks on the front of the panel or the switch. 
Check for proper connections and establish the 
connections or reseat these if required. 

2. The switch port may not be active. Check with 
the local IT person to see if this is the case and 
correct it. 

3. The data pairs (1,2 and 3,6) are not properly 
terminated on the rear of the DPoE™ Power 
Patch Panel. Re-punch the port(s) and test the 
connection again. 

 

                                            
1 If a port is wired as Alternate POE, both IEEE 802.3af-2003 Powered Devices as well as legacy Cisco 
Powered Devices will be detected and get powered up. If a port is wired as POE, only the IEEE 802.3af-
2003 Powered Devices will be detected and get powered up. 
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OPERATION 

LED Indicators 

The DPoE™ Power Patch Panel displays system and port status through the use of LEDs on the front 
and rear of each panel.  There is one panel status LED on the front left of the panel, 24 individual port 
status LEDs above each port, and twonetwork status LEDs on the rear of the unit.  These LEDs enable 
the technician to see at a glance if either the ports or the panel itself is in alarm.  (See page 5, Figure 1: 
DPoE™ Power Patch Panel (Front View) and page 6, Figure 2: DPoE™ Power Patch Panel (Rear View) 
for a graphical view of the LEDs on the DPoE™ Power Patch Panel.) 
 
The following tables do not include the LED status during powering up the unit.  (See page 15, Table 6: 
DPoE™ Power Patch Panel Power Up Sequence, for more information on the LED indications during 
power up. 
 

Table 8: Panel Status LED Indications 
LED Color Panel LED 

Status 
Description Status of Power Ports 

Off Off No Power is being supplied to the 
panel. 

Power is NOT being 
delivered to the ports on 
the panel. 

Green Flashing System operating normally. Power may be delivered 
down the ports on the 
panel, as configured. 

Amber Solid Out of voltage range condition.  
Less than 46VDC or more than 
57VDC is being supplied to the 
panel.   

Power is NOT being 
delivered to any ports on 
the panel. 

Red Solid The main processor on the panel is 
NOT operating properly and power 
is NOT being delivered to any ports 
on the panel. 

Power may or may NOT 
be delivered to any ports 
on the panel, as 
configured. 

 

Table 9: Port Status LED Indications 
LED Color Port LED Status Description Status of Power Ports 
Off Off No Powered Device (PD) is 

connected to this particular port on 
the panel.  

Power is NOT being 
delivered down this port on 
the panel. 

Amber Solid The panel is determining the PD's 
power requirements.  This occurs 
for 5 seconds after the PD is 
connected. 

Power is NOT being 
delivered down this port on 
the panel. 

Green Solid Port is providing power. Power is being delivered 
down this port on the 
panel. 
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LED Color Port LED Status Description Status of Power Ports 
Red Solid The system has failed to determine 

the PD power requirements for this 
port.  Perhaps this PD is not an 
802.3af-2003 compliant or Cisco 
legacy power device. It could also 
be a port configured for 802.3af-
2003 and an alternate PoE device 
has been connected.   
 
Also, pins (4,5) & (7,8) of a 
connected non-powered device 
such as a PC may be terminated in 
such a way that the power patch 
panel attempts to detect it as a PD. 
The Element Manager may be used 
to turn detection off (see Element 
Manager section) to this port so no 
further checks occur.  The LED will 
extinguish. 
 
This may also be an indication of a 
short in the wiring.  The connections 
at both ends of the horizontal 
cabling should be checked to 
ensure proper wiring has been 
followed. 

Power is NOT being 
delivered down this port on 
the panel. 

 

Table 10: Network Status LED Indications 
LED Color Network LED 

Status 
Description Notes 

Off Off No connection to the 
management system.   

If the system is otherwise operating 
normally and an Ethernet 10/100 cable 
is connected, this could be an issue 
with the panel's management interface.  

Green Flashing The management link on the 
DPoE™ Power Patch Panel 
is configured correctly and 
communication messages are 
currently being processed. 

Normal operation. 

Green Solid The management link on the 
DPoE™ Power Patch Panel 
is configured correctly, but no 
communication messages are 
currently being processed 
(i.e., the link is idle). 

Normal operation. 

Amber Solid The panel is currently trying 
to acquire DHCP address 
information from the network. 

If this persists for more than a minute or 
two, the daisy chain of connections 
between multiple panels may be 
incorrect or there are problems at the 
DHCP server. 
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ELEMENT MANAGER SOFTWARE 
 
The optional PANDUIT® Element Manager is used to remotely control, configure and monitor the DPoE™ 
Power Patch Panels within the network. Once installed on a shared or dedicated Windows-based 
Personal Computer (PC), the EM can be used to manage an entire network of DPoE™ Power Patch 
Panels. 
 
The PANDUIT® Element Manager is shipped on a CD-ROM included with the DPoE™ Power Patch 
Panel.  
 
NOTE: The DPoE™ Power Patch Panel does not require the EM for the panel to operate 

correctly.  An installed DPoE™ Power Patch Panel will source PoE power without the 
EM.  The EM provides an optional extra level of remote maintenance and monitoring for 
a network of panels. 

 

Hardware and Software Requirements 

Table 11: PC Minimum Requirements for EM 

Hardware Processor PC with 90-megahertz (MHz) Pentium®-class 
processor or equivalent (See note below)  

 RAM 128 MB of RAM, 256 MB recommended 
 Hard Disk Space 45 MB of available hard disk space 
 Network Access 10/100 Ethernet card 
 CD-ROM Drive  
Software Operating System  Any of the following: 

Windows® XP Professional (Service Pack 1 or 
later),  

Windows XP Home Edition (Service Pack 1 or 
later),  

Windows 2000 (Service Pack 4 for Windows 
2000). 

 Support Applications 1. Microsoft .NET Framework 1.1 Redistributable or 
later (See notes below) 

2. Microsoft Data Access Component version 2.7 or 
later (See notes below) 
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 Display Settings For XP Professional or Home Edition: 
Settings: 1024x768 or larger 

Color Quality: Medium (16-bit) or higher 

Advanced: Normal Size Fonts (96dpi) 
REQUIRED 

Appearance: Font Size Normal REQUIRED 
For Windows 2000: 

1024x768x32K colors 
Small Fonts REQUIRED (Normal 96dpi) 

 
NOTE: If Microsoft .NET Framework version 1.1 or Microsoft Data Access Components is not 

currently installed on the PC, the user will be prompted to install these software 
packages first before installing the EM.  The PANDUIT® Element Manager will not 
operate correctly without these two support applications being installed on the same PC. 

 
NOTE: Microsoft .NET Framework cannot currently be installed on 64-bit computers. 

 

Installing the Element Manager Software 

The PANDUIT® Element Manager is installed (or upgraded to a later version) by running the setup 
program on the DPoE™ Power Patch Panel Support Tools CD-ROM, included with the DPoE™ Power 
Patch Panel.  Once the CD-ROM is placed in the personal computer's CD-ROM drive, the setup program 
will automatically run and will give the user the choice to install the EM software or choose from other 
selections.  When selected, the installation software will first verify the necessary support software is 
available on the computer or will prompt the user to determine whether these packages should be 
installed along with the EM. (See page 19, Table 11: PC Minimum Requirements, for more information.) 
 
Once all required support software is installed, the PANDUIT® Element Manager installation screen will be 
displayed (see below). 
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For security purposes, the network operator will then be given the opportunity to restrict the Element 
Manager to the administrator UserName only (default) or whether other users of this PC can access it.  
Once this selection is made, the installation process completes in only a few minutes. 
 

 
 
Remove the CD-ROM from the CD-ROM drive and store it in a safe place.   
 
NOTE: The DPoE™ Power Patch Panel Support Tools CD-ROM also includes the option 

to uninstall the PANDUIT® Element Manager.   

 
 
NOTE: Critical updates to the support programs may occasionally come from Microsoft 

Corporation.  The Windows Update option from the PC’s START Menu can be used 
to periodically check for such updates. 

 

Connecting the EM Host Computer to the DPoE™ Power Patch Panel  

The computer that hosts the EM can either be directly connected to the DPoE™ Power Patch Panel or 
connected through the Ethernet network.  If the PC is directly connected to the DPoE™ Power Patch 
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Panel, the PC must either be setup as a DHCP Server or the panel but be setup for a static IP address. If 
the PC is connected to the DPoE™ Power Patch Panel through an Ethernet network, the network must 
have a DHCP Server on it or the panel must be setup for a static IP address. Once the PC is logically 
connected to the first DPoE™ Power Patch Panel, successive panels may be daisy chained to the 
previous panel by connecting the OUT management port on that panel to the IN port on the next panel. 
These connections are made via a RJ-45 standard patch cord. (See page 8, INSTALLATION, for more 
information on daisy chaining the panels together.) 
 
NOTE: There is no need to connect the OUT management port on the last DPoE™ 

Power Patch Panel in the daisy chain to anything. 
 
IMPORTANT: Directly connecting a PC to the panel will either require the PC to be setup as a 

DHCP Server or require the DPOE™ Power Patch Panel to be setup for static IP 
addressing. The panel factory default setting is DHCP addressing. 
 
If a panel is changed to static IP addressing, make sure the static IP address is 
recorded; no communication to the DPOE™ Power Patch Panel can be done 
without this address. 
 
Never connect a PC setup as a DHCP Server to an Ethernet network that already 
has a DHCP Server on it. 

 

Element Manager Operation 

Once the EM is successfully installed, access the program using the shortcut installed on the desktop by 
the EM installation software.  (The program is stored in the Panduit directory under the programs directory 
and can also be accessed through the START menu.)   
 
After displaying the version number of the EM, the user is prompted for a UserName and password.  
 
NOTE: When the management system is first installed, the default UserName is 

administrator with a password of Panduit (notice the capital “P”).   
 
Passwords are case-sensitive. 
 
This default UserName and Password should be changed once the user is 
familiar with the EM software. (See page 24, Additions or Changes to 
UserName/Password, for more information.) 
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Some of the screen shots in this section may look different on the PC running the EM. The updated EM 
presents a slightly different look to the screen shots. In some cases, additional features have been added 
(refer to the same sections in the DPoE™ 8 Port Power Hub User’s Guide for more details on the added 
features). 
 

Graphical User Interface 

The PANDUIT® Element Manager has an easy-to-use graphical user interface with pull-down menus and 
tool bars, which make configuring and provisioning the network easy. When the Element Manager 
software is opened, the following system-level opening screen appears.  
 
 
 

Tree view 
of the 
network 
area 

List view of the DPoE 
Patch Panels area 

Message 
log area 

Pull-down menus 
Tool bar 

Tool bar for 
message log 

Online  
indicator 

 

Figure 3: System-Level Opening Screen 
 
The system-level opening screen is broken into three areas: the Tree View of the Network area, the List 
View of the DPoE™ Power Patch Panels and the Message Log area.  By working in each of these three 
areas, the network operator can easily monitor the overall status of the DPoE™ Power Patch Panel 
network, the status of individual patch panels, or the status of individual ports on individual panels.  
Likewise, configuration changes can be made at the network, panel or port level. 
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The Tree View of the Network area provides a hierarchical display of each patch panel within the network 
using the configurable names assigned by the network operator. Multiple patch panels physically wired 
into a single rack are grouped on the screen under the configurable name of that rack.  Using the 
computer mouse, the operator can select a specific rack, and the display will expand to show the 
individuals panels within that rack. 
   
When the operator selects an individual rack, the EM automatically displays the information for each 
DPoE™ Power Patch Panel within that rack in the List View area (top right).  Likewise, all log messages 
relating to that rack are automatically displayed in the Message Log area (bottom right).  These 
messages indicate any conditions with the rack itself, the DPoE™ Power Patch Panels on that rack or 
individual ports on individual panels within that rack. 
 
If the operator selects an individual panel from the Tree View of the network area, a second screen, which 
overlays the Message Log and List View areas, allows the operator to configure and monitor a specific 
DPoE™ Power Patch Panel. (See page 33, Figure 4: View Panel Screen, for more information.) 
 
In addition to the three areas on the system-level opening screen, the EM provides the following 
conveniences on this system-level opening screen. 
 
9 Tool Bars – The most frequently performed actions are assigned buttons on the two tool bars to 

speed with assigning ports and panels, adding users to the management system, filtering 
incoming messages for trouble isolation etc. 

9 Pull-Down Menus – All functions available through the tool bars are also available through the 
pull-down menus, but, in addition, network-wide functions, such as copying panel information 
from an existing panel to a new panel is also available. 

9 Online Indicator – This real-time display indicates the communication status between the EM and 
the DPoE™ Power Patch Panels. 

 
The following sections discuss the actions to perform various common tasks within the Element Manager. 
 

Additions or Changes to UserName/Password  

By adding additional UserNames to the EM, the network operator can allow access to the system by 
other users without the need for sharing a single UserName/Password among multiple users. 
 
The Users option under the Tools pull-down menu provides an easy mechanism to add new or modify 
UserNames.  There is also a button ( ) on the top tool bar on the system-level opening screen to 
perform this task.   
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By clicking on the Add button, the network operator can create new UserNames and Passwords for use 
the system.  A free-form Description field is also available.   
 
Maintenance of UserNames is done by first clicking an existing Username, then clicking on either the 
Remove button to delete that UserName or the Properties button to have the following screen appear. 
 

 
 

After any changes are made, use the Close button to return to the system-level opening screen. 
 
NOTE: Passwords are case-sensitive.  Users must enter the password exactly as the 

network operator assigned it. 
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NOTE: A user cannot delete a currently active UserName. 

 

Panel Discovery 

Once the EM is connected into the network, the Discover capability can be used to "find" the deployed 
DPoE™ Power Patch Panels. (See page 21, Connecting the EM Host Computer to the DPoE™ Power 
Patch Panel, for more information.)  The EM initiates messages into the control network and requests 
responses from any panels that see this message.   

 
NOTE: Unless the DPoE™ Power Patch Panel has been configured during installation 

using the EM, this Discover capability will only receive the configuration and 
existence of the DPoE™ Power Patch panels themselves.  The network operator 
will still need to enter port and rack information, such as which racks the panels 
are wired into and where in each rack the panel is physically mounted.  (This 
information can be colleted by using the included PANDUIT® DPoE™ Power 
Patch Panel Installation Worksheet during installation.)  
 

 When installing multiple panels simultaneously, it is very important to record the 
MAC address for each panel.  Since multiple panels will return the same factory 
default settings to the Discover capability, the MAC address, which is written on a 
sticker on the back of each DPoE™ Power Patch Panel, is unique and will allow 
the network operator to distinguish one panel from another. (See page 8, 
INSTALLATION, for more information on installing the DPoE™ Power Patch 
Panels.) 

 
 

The Discover option under the Devices pull-down menu will perform this task or click the button ( ) on 
the top tool bar on the system-level opening screen.  
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The network operator can set the Discover capability to search a specific subnetwork for panels or search 
across a range of IP addresses.  The two leftmost buttons on this Discover Devices window are used to 
select which type of Discover to initiate. By selecting the top button, the top half of the screen is then used 
to request a subnetwork search.  

 
Subnetwork Search 
 
After selecting a subnetwork option, the Add, Edit, and Remove buttons become active and give 
the network operator a chance to enter or modify the subnetwork information in the EM prior to 
starting the subnetwork search. 
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IMPORTANT: The SNMP Community fields are case-sensitive and allow SNMP 
messages to be exchanged between the EM and the DPoE™ Power Patch 
Panels.  
  
FOR SECURITY REASONS, THESE FIELDS SHOULD BE CHANGED 
FROM THEIR DEFAULTS. 

 
Once any subnetwork changes are entered (if necessary), check (  ) those subnetworks to be 
searched and click the Start button.  
 

 
 
IP Range Search 
 
By selecting the bottom button on the Discover Devices screen, the bottom half of the screen is 
then used to request a IP range search as part of the Discover Capability.  
 

 
 
After entering the Starting IP Address, Ending IP Address, and SNMP Write Community, the Start 
button will initiate the Discover capability. 
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Whether a subnetwork search or an IP range search was conducted, the discovered DPoE™ 
Power Patch Panel information will be populated in the Element Manager. 
 
TIP: In addition to the Discover capability, the Element Manager also supports a 

Refresh capability, which collects the information stored in each Patch Panel and 
verifies it’s consistent with the information in the EM.  (See page 43, Refresh the 
Network, for more information.) 
 

Provisioning the Panel 

 
The Element Manager has the capability to discover all of the DPoE™ Power Patch Panels in the network 
and display them in a format where the panels are grouped by their host racks based on the information 
entered into the panels during the provisioning process. These are called the Panel Attributes. 
 
Identifying each panel individually and entering these attributes are a key part of the provisioning activity 
that allows the Element Manager and other Network Management Systems to be used in an easy and 
effective manner. It is highly recommended that the following procedure be used to provision the panel 
properly: 
 

1. During the installation of each DPoE™ Power Patch Panel, it is important to record the MAC 
address of the panel. This is needed since this is the only unique identification of the panels once 
they are placed into your network. An installation worksheet is provided to record this and other 
important information. A bar code of the MAC is also provided that allows a bar code reader to 
record this information automatically. The MAC and bar code for the MAC are found on the rear 
of the panel near the management ports.  

2. Once the DPoE™ Power Patch Panel is connected to the network and power is applied, the 
panel will obtain an IP address via DHCP. This will take 1-2 minutes depending on your network 
and DHCP server settings. 

3. Using the Discover capability of the Element Manager, search the subnet where the panels have 
been installed for the panels. 

4. When the panels are discovered they will appear in a table as shown below: 
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5. The table contains the MAC and IP address of the all of the panels. The message log will include 
the MAC and IP address of the newly discovered panel(s). The MAC Address can now be used to 
associate the discovered panel with the information contained on the installation worksheet, and 
the Panel Attributes can now be entered. 

6. Double-click on the row in the table containing the first newly discovered panel. After the panel 
information is gathered from the panel, the View Panel Screen will open and will look like this: 

 
 

Visual 
display of 
front panel

Tool Bar

Messages 
specific to 
this panel 

 
 

7. Select the Edit Panel Info and the following form will open. This is where the Panel Attributes can 
be entered. 
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The panel name, rack name, rack space position, and contact name should be entered here as 
shown above. The Element Manager will create a rack with that name, and any panel that has the 
same rack name will be grouped under that rack. This screen also includes a place to record the 
name and location information of the power system for this DPoE™ Power Patch Panel. 
 
Note that the Panel Physical entry allows a large amount of information to be entered, which 
includes additional physical and geographic information for this panel. This should also be filled 
out per the example below: 
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8. Once all of the information is entered, click the Save button and this information will be saved to 
the panel and the graphic for the rack will be shown in the Element Manager Tree View of the 
Network area along with a graphical representation of the panel with the proper name. (See page 
23, Figure 3: System-Level Opening Screen, for more information.) 

 
9. Other newly discovered panels can be easily provisioned by copying the Panel Attributes from 

this panel, and making changes where needed for the new rack names, rack positions, panel 
name, etc. This can be done by selecting the table row with the last provisioned panel, right-
clicking, and choosing “Copy Panel”. Select the next panel to be provisioned by highlighting the 
row of the panel, right clicking, and choosing “Paste Panel." All of the Panel Attributes will be 
applied to the new panel. Select “Edit Panel” and edit Panel Attributes and make the appropriate 
modifications. 

 

 
 
 
 

10. The previous step should be repeated for each panel in the network until all the panels have been 
provisioned. Once this is done, the Element Manager can easily manage all of the powered 
devices using the more intuitive physical location information that is stored in each panel. 
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Administering Port and Panel-level Information 

The PANDUIT® Element Manager makes it easy to administer the deployed network of DPoE™ Power 
Patch Panels. When a specific panel is selected in the Tree Level View of the Network on the system-
level opening screen, the EM automatically retrieves the latest power and LED information from the 
selected panel and displays on the View Panel Screen. (See pages 17 & 18, Table 8: Panel Status LED 
Indications, Table 9: Port Status LED Indications and Table 10: Network Status LED Indications for 
information on the LED Indicators. 
 

 
 

Visual 
display of 
front panel

Tool Bar

Messages 
specific to 
this panel 

 

Figure 4: View Panel Screen 
 
The top portion of the panel-level opening window provides a view of the DPoE™ Power Patch Panel, 
complete with the current LED status, IP address, rack name and rack location.  
 
There is also a second tab on this screen to view the current SNMP information currently set on this 
panel.  This screen cannot be used to modify the configuration SNMP information. 
 
The left center area of the above screen shows the current information provisioned in the panel.  It 
includes network information, configuration information, power consumption information. 
 
The bottom portion shows the log messages for this specific panel. 
 
The right center of the above screen provides a tool bar to more quickly perform the tasks associated with 
this specific panel. 

 
Edit Panel Information 
 
In addition to the Edit Panel Info button on the tool bar, the Edit Panel option under the Devices 
pull-down menu provides an easy mechanism to perform this task.   
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Figure 5: Edit Panel Screen 
 

TIP: Prior to modifying any entries on this screen, click on the Refresh button to 
retrieve the latest information stored in the specific panel. 

 
This screen will allow the network operator to change the panel IP address, the panel attributes, 
the SNMP setting, or the trap settings.  
 
After any changes are made, be sure to click on the Save button to store the information and 
transmit it to the DPoE™ Power Patch Panel. 

− Panel IP Address 
The DPoE™ Power Patch Panels come with a factory setting of DHCP address 
assignment. After the panel is connected to the EM, the network administrator may 
change this setting by adding an IP address & Subnet Mask, if desired, to be 
consistent with the rest of his/her network. The Gateway field is the IP address of a 
gateway.  If the EM and the DPoE™ Power Patch Panels are on different networks 
or if the SMTP server is on a different network from the panel, the panel will send 
those messages to the gateway IP address specified. 
 
NOTE: The DPoE™ Power Patch Panel supports either static IP addressing 

or DHCP address selection.  If the panel is set for DHCP, no other 
information is required in this section.   

 

− Panel Attributes 
This portion of the screen can be used to set the Panel Name, Rack Name, Rack 
Space Position, Panel Physical Location, and Power Supply Location.  These fields 
are freeform and, while these fields will not change the operation of the EM, they 
allow the EM to present the panel and rack information in a user-friendly format.  For 
example, with these fields set, panels in the same rack will be grouped together in 
the Tree View of the Network area on the system-level opening screen.  Likewise, 



PANDUIT® DPoE™ Power Patch Panel User’s Guide Issue 2.2 
  Part Number: PN378A 
   

  
  35  

panels wired in a single rack will be displayed consistent with the value in the Rack 
Space Position field. (See page 29, Provisioning the Panel, for more information.) 
 
Once these values are set in the EM, this information will be transmitted and stored 
in the DPoE™ Power Patch Panels. 

   
Two additional fields are available on this screen and affect the operation of the 
panel.  The first field, the Power Threshold, allows the network operator to configure 
the available power for this panel as a percentage of the maximum power the panel 
can support. For example, although the panel can support 480 watts, panels that 
use external power supplies, rather than a direct 48-volt input, are not normally 
capable of supplying 480 watts of power. Therefore, the Power Threshold for this 
panel might be set at 30%.  And the Power Warning Threshold, which tells the panel 
when to send an alarm messages, might be set at 10%, so that the panel starts 
alarming when it reaches 90% of this particular panel's maximum. (See page 47, 
EM Log Messages, for more information on Power Warning Threshold.)  
 
The Enable Trap is a checkbox (  ) to quickly turn on/off an individual panel’s 
reporting of threshold power alarms. 
 

− SNMP Settings 
 
The system defaults to public for the SNMP Read Community and private for the 
SNMP Write Community.   
 
IMPORTANT: The SNMP Community fields are case-sensitive and allow 

SNMP messages to be exchanged between the EM and the 
DPoE™ Power Patch Panels.  
  
FOR SECURITY REASONS, THESE FIELDS SHOULD BE 
CHANGED FROM THEIR DEFAULTS. 

 

− Trap Settings 
 
The Trap Setting section allows the network operator to configure the DPoE™ 
Power Patch Panel to send configuration and alarm messages to up to three 
different IP addresses. 
 
IMPORTANT: One of the Traps must be configured and set to the IP address 

of the computer running the EM in order for the EM to receive 
configuration and alarm messages from the panel. 
 
The computer running the EM should not have any other 
programs running that receive trap information. 
 

 
The IP Address, SNMP Community String and SNMP version (normally SNMP V2C) 
are set according to the destination device for these outgoing messages.  The 
Enable provides an easy on/off button for the traps without having the delete the 
above-entered information. 
 
The other fields, Critical, Major, Minor, Advisory, refer to the priority of the messages 
and allow the network operator to designate which message should be sent to each 
trap.  (See page 47, EM Log Messages, for more information.) 
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Copy/Paste/Delete Panel Information 
 
The EM also provides a unique feature that will allows the network operator to more efficiently 
configure the network by allowing all panel-level information to be copied from one panel to 
another. The Copy Panel and Paste Panel options under the Tools pull-down menu provide an 
easy mechanism to perform this task.   
 
Once a panel is highlighted in the Tree View of the Network area on the system-level opening 
screen, the View Panel Screen for that panel will appear.  Using the Copy Panel capability, will 
copy all panel-level information into a buffer.  By then selecting another panel on the Tree View of 
the Network, perhaps a newly added panel, the paste panel capability is used to paste the panel-
level information (Panel Attributes, SNMP Settings and Trap Settings) from the first panel to this 
second one.  The paste panel capability can continue by selecting another panel and selecting 
the Paste Panel option again. 
 
NOTE: The Paste Panel option does not overwrite the IP Addressing information for the 

panels.  (See page 33, Edit Panel Information, for more information.) 
 

 
 
The Delete Panel option under the Tools pull-down menu provide an easy mechanism to delete a 
panel from the EM.  This may be required if panels are being pulled from the network. Once a 
panel is highlighted in the Tree View of the Network area on the system-level opening screen, the 
View Panel Screen for that panel will appear.  Using the Delete Panel capability will erase all 
panel-level information in the EM for this panel. 
 
NOTE: Since the master copy of all Panel information in stored in the panel itself, the 

Discover capability to find the panel in the network and restore the information if 
it was erroneously deleted. 
 

 
 
Export Panel Information 
 
This capability allows the network operator to copy the configuration data associated with a given 
panel or group of DPoE™ Power Patch Panels into an Excel Spreadsheet (csv file format) or a 
flat file.   
 
In addition to the Export Port Info button on the tool bar, the Export Panel option under the Tools 
pull-down menu provides an easy mechanism to perform this task.     
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If the Refresh Data option is checked, the EM will retrieve the latest information from the selected 
panels and before prompting the network operator to enter a filename and location where the 
information can be stored on the PC.  After the panel-level information is saved, the operator is 
prompted as to whether port-level information should be stored in a separate file. 

 
View Port Information 
 
In addition to the View Port Info button on the tool bar, which will display configuration information 
for all ports on the specified panel, the operator may double-click any port on the Visual Display 
of the Front Panel portion on the View Panel Screen to view the information for that port only.  
 
Clicking the View Port Info button will display the following screen and allow the network operator 
to administer the ports on a given DPoE™ Power Patch Panel. 
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Tool bar 

Port 
information for 
all ports on the 
selected panel. 

 

Figure 6: View All Ports Screen 

− Edit Port Information 
 

Clicking any row on the port information section of this screen will bring up the 
configuration information for that individual port.  This is the same screen that will 
appear by double-clicking an individual port on the Visual Display of the Front Panel 
portion on the View Panel Screen. 

 
TIP: By holding down the <ctrl> key, the network operator can select 

multiple ports on the same Power Patch Panel. Then, by selecting 
the Edit Port Properties button on the Tool Bar, he/she can 
configure multiple ports simultaneously.  Any fields not specifically 
overwritten with new values will be left unchanged.   
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Tool Bar 

Messages 
logged for 
this port 

Curent port 
configuration 
plus EDIT 
button 

 

Figure 7: View Individual Port Screen 
 

Clicking on the Edit button will bring up the screen to edit individual ports on a 
DPoE™ Power Patch Panel.  
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If the network operator were simultaneously configuring multiple ports, the following 
screen would instead appear and any values not overwritten would be left 
unchanged.  
 

 
 
Administration Control - This setting {on/off} allows the network operator to control 
whether each individual port is sourcing PoE power.  If this field is set to off, the port 
acts like any port on a non-powered patch panel rather than a PoE port. This 
enables the network operator to mix non-powered or locally powered devices in the 
same panel as PoE devices. The factory default setting for this field is ON. 
 
Power Priority - This setting {low, high, critical} indicates whether the importance of 
maintaining PoE power to this port in low-power situations.  This field is used in 
coordination with a higher-level Network Management System (if available). 
 
PD Type - This free-form field allows the network operator to enter information on 
the Powered Device (PD), such as the type of device (IP-phone, camera etc.). 
 
Work Area Location - These free-form fields allows the network operator to enter 
information such as the location where the device is located.   
 
Legacy Detection – This setting {enabled, disabled} allows the network operator to 
specify whether this port is connected to a Cisco legacy PoE device.  If this field is 
set to enabled, the DPoE™ Power Patch Panel port will transmit Cisco-standard 
power rather than the IEEE 802.3af-2003 compliant power. 
 

Export Log 
 
This task, like the Export Panel Information capability, allows the network operator to copy the 
Log Messages from the currently selected port, rack or the entire network of DPoE™ Power 
Patch Panels to an external file.   
 
The Export Log button on the tool bar on the View Panel Screen provides an easy mechanism to 
perform this task. 
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View Entire Log 
 
The View Entire Log button on the tool bar on the View Panel Screen can be used to perform this 
task.  Viewing the message logs can also be activated from most points within the EM using the 
  button on the top tool bar. 
 
 

Message 
Log area 

Tool bar  
for Log 
Messages 

 

Figure 8: View Message Log Screen 
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The View Message Log area provides a sequential listing of all messages received by the EM, 
displaying them in a first-in, first-out manner.  That is, the most recently received messages are 
listed at the top of the window and the older messages are pushed down toward the bottom of the 
window.  The “rewind” and “fast-forward” buttons in the right half of the tool bar for the Message 
Log area are used to navigate through the message logs should it grow beyond the viewable 
area. 

− Filter Log Messages  

 By clicking on the Filter Messages button, the operator can selectively view and/or 
export a subset of the log messages.  

 
 He/She can sort through and view this subset by any combination of: 

 
-  date range, 
-  by rack number or range of rack numbers, 
-  by rack space location or range of rack space locations, 
-  by IP address or range of IP addresses,  
-  by MAC address or range of MAC addresses,  
-  by panel name or range of panel names,  
-  by port number or range of port numbers and, 
-  by any of the specific message types  
 

− Export Log 

 By clicking on the Export Log button, the operator is given the option of exporting 
the log file related to particular panel, rack or the entire log to a file. 
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− Clear Log 

 By clicking on the Clear Log button, the operator will be given the opportunity to 
export the log before erasing the entire log. 

 
NOTE: Clearing the log will clear the entire message log in the EM.  It 

cannot be used to selectively clear a portion of the log.   

 
 

Refresh the Network 

The Refresh option under the Devices pull-down menu or the button ( ) on the top tool bar provides an 
easy mechanism to make sure that the configuration and status information in a deployed network of 
DPoE™ Power Patch Panels is consistent with the EM.  Changes in network status or configuration 
changes made by a different EM operating within the same network of panels are two reasons why 
panels may have different information than the EM. 
 

 
 
The Refresh capability will allow a Refresh of the entire network, all the racks in a panel, or a single panel 
within a rack.   
 

Administering E-mail Settings 

By using the E-mail mechanism, the network operator can assign specific e-mail addresses to be notified 
of network events.  For example, the EM can be configured to send e-mail messages to one or more e-
mail addresses in the event of configuration changes, incoming alarms or other events within the network 
of DPoE™ Power Patch Panels.  There are 16 categories of messages, alarms and events, which can be 
flexibly assigned to any of the e-mail addresses. 
 
The E-Mail Settings option under the Tools pull-down menu provides an easy mechanism to add new e-
mail addresses to the system or administer which events trigger messages to which e-mail accounts.  
There is also a button ( ) on the top tool bar on the system-level opening screen to perform this task.   
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NOTE: Before any e-mail messages can be sent from the system, the SMTP Server and 
Source E-mail Address fields must be entered.  
  
The Source E-mail Address will be used as the "from" address on all e-mails 
sent from the Element Manager.  
 
Once this information is added, check the E-mail Enabled box and store the 
settings using the Save button. 
 

 
 
By clicking on the Add button, the network operator can enter a destination e-mail address that will 
receive notification e-mails when network events occur.   
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Once the e-mail addresses are entered into the system and a specific e-mail address is selected on the 
left panel of the E-mail Settings, the right panel is used to select which message categories will be sent to 
that e-mail address. (See page 47, EM Log Messages, for more information on each of these message 
types.) 

 
NOTE: The same category of events may be selected for multiple destination e-mail 

addresses. 

 
The Edit button is used to change the e-mail address of an already assigned e-mail address without the 
need to delete and reenter the selection criteria.  
  

Search for Specific Panel(s) or Port(s) 

The Search option under the Tools pull-down menu or the button ( ) on the top tool bar provides an 
easy mechanism to search the EM for specific panel(s) or port(s).   
 
NOTE: The * character may be used to perform wildcard searches. 

 
The first screen to appear is the Panel Search option.  An alternate tab can be selected to perform a 
search for a specific port. 
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 Tabs 

 
 

Panel level searches can be conducted by any combination of:  
 
- MAC address, 
- Panel Name, 
- Rack Name, 
- Rack Space Location 
- Hardware Version, 
- IP Address, 
- Physical Location, 
- Power Supply Location, 
- Firmware Version. 
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Port level searches can be conducted by any combination of:  
 
- Port Number, 
- PD Type, 
- Work Area Location 
- Administration Control, 
- Detection Status, 
- Power Priority, 
- Power Classification, 
- Legacy Control. 

 
EM Log Messages 

The following types of messages are generated within the DPoE™ Power Patch Panel network and are 
displayed in the EM logs. While most of these messages are generated by a DPoE™ Power Patch Panel 
in the network, several of these messages originate within the EM when, for example, it looses 
communication with one of the panels in the network. 
 

Table 12: EM Log Messages 
Message Category Priority 

Level 
Description 

Undiscovered Panel – Cold Start Advisory The main software process (i.e., the panel 
agent) in a previously unknown panel is 
now up and running. 
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Message Category Priority 
Level 

Description 

Panel Agent – Cold Start Advisory The main software process (i.e., the panel 
agent) in a previously known panel is now 
up and running. The process likely reset 
itself 

New Panel Discovered Advisory The Discover capability has found a new 
panel.   

PD Connected Minor A new Powered Device has been detected 
at the panel. 

PD Disconnected Minor A Powered Device has been disconnected. 
Panel Power Above Threshold Major The power consumption at the panel has 

risen above the Power Warning Threshold. 
Panel Power Below Threshold Major The power consumption at the panel has 

fallen below the Power Warning Threshold. 
Panel Failure Critical The fuse has blown on the power-

forwarding portion of a patch panel. 
Port Physical Location Changed Advisory Location information of one of the ports has 

changed using the EM.  
Trap Recipient Changed Advisory One of the traps associated with a particular 

panel was changed using the EM.  
PD Detection Failure Major Panel detected failure with one of the 

Powered Devices. 
Panel Agent Lost Communication Critical EM cannot communicate with the specified 

panel.  
IP Address Changed Advisory The IP address at one of the panels has 

changed using the EM. 
 
 

Miscellaneous Settings 

Several miscellaneous settings must be configured for the PANDUIT® Element Manager to communicate 
properly with a deployed network of Power Patch panels. 
 
The Settings option under the Tools pull-down menu provides an easy mechanism to administer these 
settings.   
 



PANDUIT® DPoE™ Power Patch Panel User’s Guide Issue 2.2 
  Part Number: PN378A 
   

  
  49  

 
 
If the Online indicator is not checked (  ), the EM assumes it is in the offline mode and will not attempt to 
connect to the deployed Patch Panel Network.  Changes made within the EM will not be updated in the 
panels. 
 
When the power consumed on any given panel reaches the Power Warning Threshold below the 
maximum power level for that particular panel, the panel will issue a warning alarm and display that the 
panel is in the warning range.   
 
NOTE: This above setting is a system-wide power warning threshold, but it used as a 

percentage below maximum for each individual panel.  Some panels in the 
network might have their maximum panel power set at different levels and 
therefore would alarm at different points.  (See page 33, Edit Panel Information, 
for more information on the Power Threshold field.) 

 
Rack Space Numbering is a system-wide field {ascending, descending} that enables the EM to display 
the panels in the racks in the same fashion as they are wired in the network racks.  Either the rack slots 
are numbered from with the highest rack positions at the top (descending) or the highest rack positions at 
the bottom (ascending). By setting this parameter appropriately, the rack-level displays presented by the 
EM will show the DPoE™ Power Patch Panels in their installed top-to-bottom order. 
 
The SNMP Timeout Value is a configurable threshold.  If more than this number of seconds has expired 
and the system hasn’t yet received an answer to a previously transmitted SNMP message, the system will 
assume there is a communications problem. 
 

DPoE™ Power Patch Panel Firmware Update  

The DPoE™ Power Patch Panel has the ability to have its firmware programmed remotely. A Trivial File 
Transfer Protocol (TFTP) operation can be initiated using the Element Manager (EM). The Firmware 
Update option under the Tools pull-down menu provides a method to perform the update.  
 
 
NOTE: The latest version of firmware may be downloaded after product registration at 

www.panduit.com/ManagedNetworkSolutions 
The panduit.com website will allow users to download firmware updates to their own 
TFTP server. 
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NOTE: An important feature of the DPoE™ Power Patch Panel is its ability to continue 
supplying Power over Ethernet during firmware updates.  All IEEE 802.3af and 
Cisco In-Line protocol legacy powered devices connected to the Panel will remain 
powered during a firmware update. Cisco In-Line protocol legacy new powered 
device detection may experience an interruption during a firmware update.  

 
Insure that the DPoE™ device is connected to a Network with the PC that has the Element Manager 
application running and has the device to be programmed discovered (see Device Discovery Section). 
 

Detailed Description of the Firmware Update 

 
1. Download the new DPoE™ product file from www.panduit.com/ManagedNetworkSolutions to a 

directory location on your intranet (internal network). 
 
2. Start a local TFTP server. This may require downloading and configuring TFTP server freeware 

or shareware from the Internet (refer to the TFTP Server Install Document). Note: When 
configuring your TFTP Server, the TPTF root directory must point to the directory where the new 
DPoE™ product file is stored. 

 
3. The Firmware Update option under the Tools pull-down menu opens a window that identifies the 

IP address, device type and device name. The window as shown in the EM Firmware Update 
Screen can then be used to initiate the TFTP firmware update by the user entering the firmware 
filename and IP address of the TFTP server. 
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4. Enter the TFTP information in the EM screen and then click on the Begin Update button. 
 
5. Observe the System status LED begins flashing red on the DPoE™ Power Patch Panel. See 

Table 12A: DPoE™ Power Patch Panel Firmware Update LED status for the LED activity during 
the Firmware update. 

 
6. Allow sufficient time for the Firmware Update to complete. (Approximately 10 minutes) 

 
7. When the Firmware Update is complete the System status LED resumes flashing green. 

 

Table 13A: DPoE™ Power Patch Panel Firmware Update LED Status 
 

System LED  
Color and activity 

Network LED  
Color and activity 

State Description Elapsed Time  

 
Off 

Ethernet Switch 
Initialization 

00 – 01 seconds 

Amber Solid  DHCP Initialization 

 
Red Solid 

Green Blink DHCP complete 
 

01 – 100 
seconds 
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System LED  
Color and activity 

Network LED  
Color and activity 

State Description Elapsed Time  

Red rapid Blink Image transfer and 
update in progress  

5 - 7 minutes 

Red slow Blink CRC code 4 seconds 
Red Solid Image update  

complete 
END 

Green Slow Blink 

 
Green Blink 

Application Running  

 

 
 

Exiting the PANDUIT® Element Manager 

The Exit option under the File pull-down menu or the button ( ) will exit the EM.   
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APPENDIX 1 – DPOE24S1X AND DPOE24S1XY 
INSTALLATION 
 
The PANDUIT® DPoE™ Shielded Power Patch Panel requires a direct connection to a nominal 48VDC 
supply.  An individual power supply may be purchased separately from PANDUIT Corp or other vendors.  
Installation instructions for the individual power supply are included with that product. PANDUIT Corp 
provides multiple individual power supply options as listed below. 
 

Table 14: Power Supplies Available from PANDUIT Corp. 
PANDUIT Part Number Description 
DPOEPWRB120 120 watt power brick - 48 volt output 

DPOEPWRCU 

Unmanaged power chassis - supports 3 
rectifiers and optional Network Interface Card 
(NIC) 

DPOEPWRR500 
500 watt rectifier for use in the DPOEPWRCU 
chassis 

DPOEPWRR1250 
1250 watt rectifier for use in the DPOEPWRCU 
chassis 

CORD-A Power cord for Australia 
CORD-E Power cord for Europe 
CORD-S Power cord for USA 
CORD-U Power cord for the U.K. 

 

Package Contents 

Each PANDUIT® DPoE™ Shielded Power Patch Panel is shipped in a box that includes the following: 
 

Table 15: Package Contents 
Item Quantity Notes 
DPOE24S1X or DPOE24S1XY Power Patch Panel 1 The shielded version of the 

DPOE24U1X or DPOE24U1XY. 
Rear shields 2 Top and bottom rear shields. 
Wiring Template Label 1 For use on the rear panel of the 

DPOE24S1X or DPOE24S1XY – 
Supports either EIA/TIA 568A or 
568B wire positions. 

Quick Installation Instructions 1 PANDUIT Part Number PN404 
DPOE™ Power Patch Panel Installation Worksheet 1 PANDUIT Part Number PN377 
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Item Quantity Notes 
Metric and English screws  13 Installation requires six screws.  

One bag of six metric screws 
(M6x1.0x16), one bag of six 
English screws (12-24x1/2”), and 
an additional screw for the rear 
shield are included.  

8 inch grounding strap 1 Used to ground the panel to the 
frame. 

DPoE™ Power Patch Panel Support Tools CD-
ROM containing: 

- PANDUIT Element Manager (EM) 
software. 

- DPoE™ Power Patch Panel Users Guide 
(this document) 

1  

Power connector housing with wire leads 1 This wiring harness is used to 
connect the DPoE™ Power Patch 
Panel to the 48VDC power 
supply. (Not used if the panel is 
powered by an individual power 
supply.) 

10 Foot Power Harness 1 Used to connect the –48V A-feed 
to a power supply.   

Butt splices 2 Two butt splices may be used to 
extend the 10 Foot Power 
Harness. (Do not exceed a total 
length of 35 feet). 

Copper Tape 4 This tape is used to wrap around 
the shielded cable foil or braid.  

PAN-TY’S 30 The PAN-TY’S are used to secure 
the shielded cable to the rear 
shield, and secure the shield.  

 
Verify the above contents arrived in good condition.  If not, contact PANDUIT Technical Support. 
 
 

Table 16: PANDUIT Corp Contact Information 

PANDUIT Technical Support Fax: 1-708-444-6993 
E-mail: cs@panduit.com 

For Installation Instructions in Local Languages 
and Technical Support 

www.panduit.com/resources/install_maintain.asp 

Worldwide Subsidiaries and Sales Offices www.panduit.com 

Latest Software Updates www.panduit.com/managednetworksolutions 
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IMPORTANT: The DPOE™ Power Patch Panel Installation Worksheet should be used to record 
pertinent information when installing DPoE™ Power Patch Panel(s), particularly if 
the PANDUIT® Element Manager is monitoring the network.  (See page 29, 
Provisioning the Panel, for more information on how this information will be 
entered in the EM.)   The installer should complete this worksheet.
 

Panel Mounting Procedure 

WARNING: Only trained and qualified service personnel should install or service 
DPoE™ Power Patch Panels 

 
WARNING: Before installing or servicing DPoE™ Power Patch Panels or 

communication wiring, be aware of the hazards with the associated 
electrical circuitry. 

Rack Mounting Instructions 

1. Record the MAC address, printed on a 
sticker on the back of the unit, by 
writing it in the space provided on the 
included Installation Worksheet 
(PANDUIT part number PN377). 

2. Slip the Wiring Template Label over 
the rows of connectors on the back of 
the DPoE™ Power Patch Panel, 
making sure the proper wiring color 
code is facing out and that the writing 
is not upside down.  One side of the label indicates EIA/TIA 568A wiring, while the other side is 
EIA/TIA 568B. 

3. Using four of the enclosed metric screws, install the PANDUIT® DPoE™ Shielded Power Patch 
Panel into the 19” rack at the planned rack position.  

 
 

WARNING: The supplied screws are part of a grounding system to ensure that the 
DPoE™ Power Patch Panel is properly grounded to the rack.   
 
USE ONLY THE SUPPLIED SCREWS TO ATTACH THE PANEL TO 
THE RACK. 
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4. Record the rack space position on the Installation 

Worksheet. 
5. Prepare the shielded cables for termination using 

the figures appropriate for the type of cable used. 
Caution: Do not damage conductors. To ensure 
the highest shielding effectiveness, cut 1.5” (38.1 
mm) of copper tape, included in 4 strips inside the 
Power Patch Panel Installation Kit, and wrap it 
around the cable foil or braid. Refer directly to the 
Installation Instructions or the diagrams below for 
proper cable termination depending on the type of 
shielded cable being used: 

 
 
 
 
 

 
Connecting the Powered Devices 
 
6. After the cables are properly terminated, place conductors into the punchdown slots in the 

appropriate wiring sequence. In order to support pre-standard powered devices utilizing Cisco 
Inline Power, the ALT POE "A" or ALT POE "B", corresponding to a EIA/TIA 568A or EIA/TIA 
568B configured data pairs, wiring sequence must be used.  
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Table 17: Color-Coded Wire Positions for 802.3af-2003 Compliant Devices 
Pin 
Outs EIA/TIA 568A  

Pin 
Outs EIA/TIA 568B 

5 WHITE/BLUE  5 WHITE/BLUE 
4 BLUE  4 BLUE 
1 WHITE/GREEN  1 WHITE/ORANGE 
2 GREEN  2 ORANGE 
3 WHITE/ORANGE  3 WHITE/GREEN 
6 ORANGE  6 GREEN 
7 WHITE/BROWN  7 WHITE/BROWN 
8 BROWN  8 BROWN 

 
 
The DPoE™ Power Patch panel supports standard IEEE 802.3af-2003 devices as well as alternate PoE 
devices consistent with the Cisco legacy devices. 

 

Table 18: Color-Coded Wire Positions for Alternate PoE Devices 
Pin 
Outs EIA/TIA 568A  

Pin 
Outs EIA/TIA 568B 

5 WHITE/BROWN  5 WHITE/BROWN 
4 BROWN  4 BROWN 
1 WHITE/GREEN  1 WHITE/ORANGE 
2 GREEN  2 ORANGE 
3 WHITE/ORANGE  3 WHITE/GREEN 
6 ORANGE  6 GREEN 
7 WHITE/BLUE  7 WHITE/BLUE 
8 BLUE  8 BLUE 

 
 
7. For best performance, the cable pair twists should be maintained as close as possible to the point 

of termination. Punchdown the conductors with a 110 Punchdown tool (PANDUIT part 
no.PDT110). Record port information on the PANDUIT DPoE™ Power Patch Panel Installation 
Worksheet (PANDUIT part no. PN377*). To ensure proper shielding, there must be approximately 
1" (25.4 mm) between the cable foil or braid covered with copper tape and the punchdown 
connector. 

 

NOTE: The DPoE™ Power Patch Panel can 
terminate most 22-24 AWG solid or 
stranded IWC wire with a .050” 
(1.27mm) max o.d. either PVC or 
Plenum rated. 
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From 
Network

 
 

 
Networking The Panels (Optional) 

 

8. If the Element Manager is not being used to 
remotely manage the network of DPoE™ 
Power Patch Panels, skip to Power 
Requirements. Otherwise, using a standard 
patch cord (for example, PANDUIT part 
number UTPCH3 or UTPSP3), connect the 
IN management port on the back of the 
panel to an Ethernet switch. A DHCP Server 
must be on this network (unless the DPoE™ 
Power Patch Panel has been configured for 
Static IP operation). The panel may also be 

directly connect to a PC with the PANDUIT 
Element Manager installed, but this PC must 
be setup as a DHCP Server. 
 

9. If multiple panels are being used in the 
network, the OUT management port from one 
panel can be connected to the IN management 
port on the next panel in a daisy chain fashion, 
as shown. Once all of the connections are 
made, the EM or another Network Manager will 
be able to communicate with all the panels 
over this daisy chain of connections. (See 
page 29, Provisioning the Panel, for more 
information.) 
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Power Requirements 

10. If the panel is being powered by an individual power supply, such as a PANDUIT® DPoE™ 
Power Patch Panel Power Supply (See page 8, Table 1: Power Supplies Available from 
PANDUIT Corp for a list of available powering options), skip to Powering Up The DPoE™ Power 
Patch Panel below, since the individual power supply is normally equipped with a matched keyed 
power connector that will fit the power connector on the back of the panel. 

11. If the panel is being powered by a direct 48VDC source, strip the power leads on the included 
keyed power connector housing to 5/16” (7.9 mm).  Strip the 48VDC supply wires to the same 
strip length, being careful not to damage the conductors.   

12. Using the two butt splices provided with the panel, and paying attention to the polarity of the 
supply voltage, crimp the power harness wires to the supply wires. A crimping tool, such as the 
PANDUIT part number CT-100, can be used. The provided butt splices (PANDUIT part number 
BSV14X) support 14-16 AWG solid or stranded wire. 

 

 
 
 

 
 

WARNING: The power supply connections are polarized.  
 
The DPoE™ Power Panel will not function if power is wired improperly. 

 
 

NOTE: The included power harness has two wires for the A-feed power only (pins 
1 & 2).  The DPoE™ Power Patch Panel supports an optional redundant 
B-feed power option, but the terminals and wire leads are not attached to 
the power harness. 
 
Contact PANDUIT Technical Support for more information about 
connecting the redundant B-Feed Power. 

 
13. Lightly tug on the butt spliced connections to verify that the butt splices are secure. 
14. Plug the connector into the back of the DPoE™ Patch Panel. 
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15. Attach the top and bottom rear shields to the panel using the tabs on the shields. Be sure that the 
compliant conductive foam on the shields is in contact with the copper tape applied to the cables. 
Close the shields together over the cables and secure with PAN-TY's (PANDUIT part no. PLT1.5I-
M). Fasten the shields together using US standard screws with the grounding strap in-between 
the screw and the shields. 

 

 
16. Secure the cables to the shield tabs with the remaining PAN-TY's. 
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Powering Up the DPoE™ Power Patch Panel                   

 
17. Apply power the panel. Once power is applied to the unit, the DPoE™ Power Patch Panel will go 

through its power up sequence.  The following table describes the behavior of the unit as viewed 
from the front and the back. 

 

 
 

Table 19: DPoE™ Power Patch Panel Power Up Sequence 
Behavior as viewed from the back of the unit Behavior as viewed from the front of the unit 

Both network status LEDs will light amber for two 
seconds 

The panel status Light-Emitting Diode (LED) will 
light red for about 10 seconds. After that, a LED 
test sequence of the port status LEDs will take 
place, lighting each port status LED amber.  It will 
appear as if the port status LED is “walking” from 
port 1 through port 24.  

If there is no cable connected to the IN 
management port (Step 9 above), both network 
status LEDs will turn ff. 

If the Patch Panel is configured for Dynamic Host 
Control Protocol (DHCP) address assignment and 
a cable is NOT connected to the IN management 
port on the rear of the panel, the panel status LED 
will blink green.   

If the DPoE™ Power Patch Panel is configured 
for DHCP address assignment (default factory 
setting), the network status LED above the IN 
management port will stay amber and the 
network status LED above the OUT management 
port will turn off.  This indicates that the panel is 
actively requesting addressing information from 
the network. Once this information is received 
(this could take up to a minute), the network 
status LED above the IN management port will 
turn green. 

If the DPoE™ Power Patch Panel is configured for 
DHCP address assignment (default factory setting), 
the panel status LED will flash amber.  This 
indicates that the panel is actively requesting 
addressing information from the network. Once this 
information is received (this could take up to a 
minute), the panel status LED will flash green as 
power is applied to the unit. (See page 5, Figure 1: 
DPoE™ Power Patch Panel (Front View) and page 
6, Figure 2: DPoE™ Power Patch Panel (Rear 
View) for a graphical view of the LEDs on the 
DPoE™ Power Patch Panel.) 

If the panel were set to static IP addressing rather 
than DHCP, the network status LED above the IN 
management port will immediately turn green. 

If the panel were set to static IP addressing rather 
than DHCP, the panel status LED will flash green 
and continue flashing as long as power is applied 
to the unit. 
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TECHNICAL SPECIFICATIONS  
 

Dimensions: 24 port 1.72”H x 19.0”W x 5.08”D (43.7mm x 482.6mm x 129.0mm) 1RU 
Input Voltage Range: 46VDC to 57VDC  

Typical per port power 
output IEEE 802.3af-2003 compliant power, 16.1 watts/port (46VOUTDC @ 350mA) 

Maximum overall 
power consumption 490 Watts (57VINDC @ 8.6 A) 

Mounting Option: 
Mounts to standard EIA 19” rack or 23” rack when used with panel extender 
brackets (PANDUIT part number PEB1). Extender brackets are not included 
with the DPoE™ Power Patch Panel. 

Packaging See page 8, Table 2: Package Contents 
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GLOSSARY 
 
AWG American Wire Gauge    
DHCP Dynamic Host Configuration Protocol    
EM Element Manager    
IEEE Institute of Electrical and Electronic 

Engineers 
   

IP Internet Protocol    
LED Light-Emitting Diode    
MAC Media Access Control    
MHz Megahertz    
NMS Network Management System    
o.d. Outside Diameter    
PC Personal Computer    
PD Powered Device    
PoE Power Over Ethernet    
SNMP Simplified Network Management 

Protocol 
   

UPS Uninterruptible Power Supply    
V2C SNMP Version 2 Communications    
VDC Volts – Direct Current    
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